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Лабораторная работа № 1 
 

Построение нечеткой аппроксимирующей системы  
для решения задачи интерполяции 

 

Цель работы. Знакомство с графическим интерфейсом Fuzzy Logic 
Toolbox. 

В состав программных средств Fuzzy Logic Toolbox входят следую-
щие основные программы, позволяющие работать в режиме графического 
интерфейса: 

● редактор нечеткой системы вывода Fuzzy Inference System Editor 
(FIS Editor или FIS-редактор) вместе со вспомогательными программами – 
редактором функций принадлежности (Membership Function Editor), редак-
тором правил (Rule Editor), просмотрщиком правил (Rule Viewer) и про-
смотрщиком поверхности отклика (Surface Viewer); 

● редактор гибридных систем (ANFIS Editor, ANFIS-редактор); 
● программа нахождения центров кластеров (программа Clustering –

кластеризация). 
Набор данных программ предоставляет пользователю максимальные 

удобства для создания, редактирования и использования различных систем 
нечеткого вывода. 

 

Задание к лабораторной работе 
 

Командой (функцией) Fuzzy из режима командной строки запускает-
ся редактор нечеткой системы вывода. Вид открывающегося при этом окна 
приведен на рис. 1. 

 

 
 

Рис. 1. Вид окна FIS Editor 
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Строка меню редактора содержит следующие позиции: 
 File – работа с файлами моделей (их создание, сохранение, считы-

вание и печать); 
 Edit – операции редактирования (добавление и исключение вход-

ных и выходных переменных); 
 View – переход к дополнительному инструментарию. 
Попробуем сконструировать нечеткую систему, отображающую за-

висимость между переменными х и у, заданную с помощью таблицы 1, ис-
пользуя алгоритм  (Sugeno), на примере  зависимости у = х2. 

 

Таблица 1 
Значения х и у 

 

х –1 –0,6 0 0,4 1 
у 1 0,36 0 0,16 1 

 
1. В меню File выбираем команду New Sugeno FIS (Новая система 

типа Sugeno), должна появиться надпись Untitted2 (Sugeno). 
2. Щелкнем на блоке, озаглавленном Inputl (Вход1). В правой части 

редактора в поле Name (Имя) вместо Inputl введем обозначение нашего 
аргумента х. Можно щелкнуть в любом месте блока или нажать клавишу 
Enter после ввода. 

3. Дважды щелкнем на этом  блоке. Перед нами откроется окно ре-
дактора функций принадлежности – Membership Function Editor. Откроем 
меню Edit данного редактора и выберем в нем команду Add MFs  
(Add Membership Functions – Добавить функции принадлежности). В диа-
логовом окне добавим недостающее количество функций принадлежности  
к входному сигналу к переменной х. Выберем гауссовы функции при- 
надлежности (gaussmf), их количество должно быть равным, например,  
пяти – по числу значений аргумента в таблице 1. Подтвердим ввод инфор-
мации нажатием кнопки ОК. 

4. В поле Range (Диапазон) установим диапазон изменения х от –1  
до 1, т. е. диапазон, соответствующий значениям таблицы 1. Затем щелк-
нем левой кнопкой мыши где-нибудь в поле редактора (или нажмем кла-
вишу Enter).  

5.  В графиках заданных нами функций принадлежности необходимо, 
чтобы ординаты максимумов этих функций совпадали с заданными значе-
ниями аргумента х. Для этого подводим указатель к нужной кривой и щел-
каем левой кнопкой мыши, она окрашивается в красный цвет, после чего  
с помощью мыши ее можно подвинуть в нужную сторону (более точ- 
ную установку можно провести, изменяя числовые значения в поле  
Params (Параметры). Каждой функции принадлежности соответствуют 
два параметра, при этом первый определяет размах кривой, а второй – по-
ложение ее центра. 
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6. В поле Name можно изменить имя для выбранной кривой (завер-
шая ввод каждого имени нажатием клавиши Enter) пяти кривым, напри- 
мер, так: 

o самой левой – x1,  
o следующей – x2,  
o центральной – x3,  
o следующей за ней справа – x4, 
o самой правой – x5. 
Нажмем кнопку Close и выйдем из редактора функций принадлеж-

ности, возвратившись в окно редактора нечеткой системы (FIS Editor). 
7. Сделаем однократный щелчок на голубом квадрате (блоке), оза-

главленном Outputl (Выход1). В поле Name заменим имя Outputl на у  
(как в п. 2). 

8. Дважды щелкнув на выделенном блоке,  перейдем к редактору 
функций принадлежности. В меню Edit выберем команду Add MFs.  
Появляющееся затем диалоговое окно позволяет теперь задать в качестве 
функций принадлежности только линейные (linear) или постоянные  
(constant) – в зависимости от того, какой алгоритм Sugeno (1-го или  
0-го порядка) мы выбираем. Выбираем постоянные функции принадлеж-
ности с общим числом 5 (по числу различных значений у в табл. 1). Под-
твердим введенные данные нажатием кнопки ОК. 

9. Диапазон изменения (Range), устанавливаемый по умолчанию 
[0,1], менять в данном случае не нужно. Изменим лишь имена функций 
принадлежности (их графики при использовании алгоритма Sugeno для 
выходных переменных не приводятся), например, задав их как соответ-
ствующие числовые значения y, т. е. {1, 0.36, 0, 0.16, 1}; одновременно эти 
же числовые значения введем в поле Params. Затем закроем окно нажа- 
тием кнопки Close и вернемся в окно FIS-редактора. 

10. Дважды щелкнем на среднем (белом) блоке, при этом раскроется 
окно еще одной программы – редактора правил (Rule Editor). Введем соот-
ветствующие правила. При вводе каждого правила необходимо обозначить 
соответствие между каждой функцией принадлежности аргумента х  
и числовым значением у. Кривая, обозначенная нами х1, соответствует  
х  –1, т. е.  y = 1. Выберем поэтому в левом поле (с заголовком х is) вариант 
х1, а в правом y1 и нажмем кнопку Add rule (Добавить правило). Введенное 
правило появится в окне правил и будет представлять собой такую запись: 

1. If (x  is  x1) then (y  is  y1) (1). 
Аналогично поступим для всех других значений х, в результате чего 

сформируется набор из пяти правил. Закроем окно редактора правил и воз-
вратимся в окно FIS-редактора. Построение системы закончено, и можно 
начать эксперименты по ее исследованию. Заметим, что для большинства 
опций были сохранены значения по умолчанию. 
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11. Предварительно сохраним на диске (используя команды меню 
File > Export to disk ) созданную систему под каким-либо именем, напри-
мер Prob или со своим именем. 

Раскроем меню View. С помощью его команд Edit membership  
functions и Edit rules можно совершить переход к двум рассмотренным  
ранее программам – редакторам функций принадлежности и правил  
(то же можно сделать нажатием клавиш Ctrl+2 и Ctrl+З). Рассмотрим две 
другие команды – View rules (Просмотр правил) и View Surface (Просмотр 
поверхности). Выбираем эти команды. 

12. В правой части окна в графической форме представлены функции 
принадлежности аргумента х, в левой – функции принадлежности пере-
менной выхода у с пояснением механизма принятия решения. Когда крас-
ная вертикальная черта перемещается с помощью мыши, изменяется зна-
чение переменной входа (можно задавать числовые значения в поле Input 
(Вход)), при этом соответственно изменяются значения у в правой верхней 
части окна. Зададим, например, х = 0,5 в поле Input и нажмем затем кла-
вишу Enter. Значение у сразу изменится и станет равным 0,202. 

Таким образом, с помощью построенной модели и окна просмотра 
правил можно решать задачу интерполяции, то есть задачу, решение кото-
рой и требовалось найти. Изменение аргумента путем перемещения крас-
ной вертикальной линии очень наглядно демонстрирует, как система опре-
деляет значения выхода. 

13. Смоделированное системой по таблице данных (см. табл. 1) 
отображение не очень-то напоминает функцию х2, так как число экспери-
ментальных точек невелико, да и параметры функций принадлежности 
(для х) выбраны, скорее всего, неоптимальным образом. В следующей ра-
боте рассмотрим возможность улучшения качества подобной модели. 

В заключение рассмотрения примера отметим, что  на любом этапе 
проектирования нечеткой модели в нее можно внести необходимые кор-
рективы вплоть до задания какой-либо особенной пользовательской функ-
ции принадлежности. Из опций, устанавливаемых в FIS-редакторе по 
умолчанию при использовании алгоритма Sugeno, можно отметить следу-
ющие: 

● логический вывод организуется с помощью операции умножения 
(prod); 

● композиция организуется с помощью операции логической суммы 
(вероятностного ИЛИ, probor); 

● приведение к четкости организуется дискретным вариантом цент-
роидного метода (взвешенным средним, wtaver). 

При использовании соответствующих полей в левой нижней части 
окна FIS-редактора данные опции можно при желании изменить. 

Построить нечеткую аппроксимирующую систему, выбрав зависи-
мость по своему варианту. 

Электронный архив УГЛТУ
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Лабораторная работа № 2 
 

Графический интерфейс гибридных систем 
 

Цель работы. Создать гибридную систему по ранее выполненной 
зависимости у = х2. 

Графический интерфейс гибридных (нечетких) нейронных систем 
вызывается функцией anfisedit (из режима командной строки). Использо-
вание функции приводит к появлению окна редактора гибридных систем 
(ANFIS Editor, ANFIS-редактор). 

С помощью данного редактора осуществляются создание или загруз-
ка структуры гибридной системы, просмотр структуры, настройка ее пара-
метров, проверка качества функционирования такой системы. Создание 
структуры, настройка параметров и проверка осуществляются по выбор-
кам (наборам данных) – обучающая (Training data), проверочная (Checking 
data) и тестирующая (Testing data). Предварительно они должны быть 
представлены в виде текстовых файлов (с расширением .dat и разделите-
лями-табуляциями), первые столбцы которых соответствуют входным пе-
ременным, а последний (правый) – единственной выходной переменной; 
количество строк в таких файлах равно количеству образцов (примеров). 
Так, обучающая выборка, сформированная по таблице 1, представляется  
в виде Ргоbа.dat: 

 

–1         1 
–0.6     0.36 
  0.00    0.00 
  0.4      0.16 
  1           1 
 

Строгих рекомендаций по объемам указанных выборок не существу-
ет; по-видимому, лучше всего исходить из принципа «чем больше, тем 
лучше».  

Обучающая и проверочная выборки непосредственно задействуются 
в процессе настройки параметров гибридной сети. Проверочная – для вы-
яснения ситуации, не происходит ли так называемого переобучения сети, 
при котором ошибка для обучающей последовательности стремится к ну-
лю, а для проверочной – возрастает; впрочем, наличие проверочной вы-
борки не является строго необходимым, оно лишь крайне желательно. Тес- 
товая (или тестирующая) выборка применяется для проверки качества 
функционирования настроенной (обученной) сети. Поясним пункты меню 
и опции редактора. 

Меню File и View в общем идентичны аналогичным меню FIS-ре- 
дактора за тем исключением, что здесь работа может происходить только  
с алгоритмом нечеткого вывода Sugeno. Меню Edit содержит единствен-
ную команду – Undo (Отменить выполненное действие). Набор опций 

Электронный архив УГЛТУ



8 

 

Load data (Загрузка данных) в нижней левой части окна редактора вклю-
чает в себя: 

 тип (Туре) загружаемых данных (для обучения – Training, для те-
стирования – Testing, для проверки – Checking, демонстрационные – Demo); 

 место, откуда должны загружаться данные: с диска (disk) или  
из рабочей области MATLAB (workspace). 

К данным опциям относятся две кнопки, нажатие на которые приво-
дит к требуемым действиям – Load Data (Загрузить данные) и Clear Data 
(Стереть данные). 

Следующая группа опций (в середине нижней части окна ANFIS-
редактора) объединена под именем Generate FIS (Создание нечеткой си-
стемы вывода). Данная группа включает в себя следующие опции: 

 загрузку структуры системы с диска (from disk); 
 загрузку структуры системы из рабочей области MATLAB (from 

worksp.); 
 разбиение (деление) областей определения входных переменных 

(аргументов) на подобласти – независимо для каждого аргумента (Grid 
partition); 

 разбиение всей области определения аргументов (входных  
переменных) на подобласти – в комплексе для всех аргументов 
(Sub.clustering). 

Кроме того, имеется также кнопка Generate FIS, нажатие которой 
приводит к процессу создания гибридной системы с точностью до ряда па-
раметров. 

Следующая группа опций – Train FIS (Обучение нечеткой системы 
вывода) позволяет: 

1) определить метод «обучения» (Optim.Method) системы (т. е. метод 
настройки ее параметров) – гибридный (hybrid) или обратного распростра-
нения ошибки (backproba); 

2) установить уровень текущей суммарной (по всем образцам) ошиб-
ки обучения (Error Тоleгanсе), при достижении которого процесс обучения 
заканчивается, и количество циклов обучения (Epochs), т. е. количество 
«прогонов» всех образцов (или примеров) обучающей выборки. 

Процесс обучения, таким образом, заканчивается либо при достиже-
нии отмеченного уровня ошибки обучения, либо после проведения задан-
ного количества циклов. 

Кнопка Тгаin Now (Начать обучение) запускает процесс обучения, 
т.е. процесс настройки параметров гибридной сети.  

В правом верхнем углу окна ANFIS-редактора выдается информация 
(ANFIS Info) о проектируемой системе: количество входов, выходов, 
функций принадлежности входов. Нажатие кнопки Structure (Структура) 
позволяет увидеть структуру сети. Кнопка Сlear (Очистить) позволяет сте-
реть все результаты. 
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Опции Test FIS в правом нижнем углу окна позволяют провести 
проверку и тестирование созданной и обученной системы с выводом ре-
зультатов в виде графиков. Соответствующие графики для обучающей вы-
борки – Training data, тестирующей выборки – Testing data  и провероч-
ной выборки – Checking data. Кнопка Теst Now позволяет запустить ука-
занные процессы. 

Задание к лабораторной работе 

Работу с редактором рассмотрим на примере восстановления зави-
симости у = х2 по данным табл. 1. Предположим, что эти данные подготов-
лены в файле Рrobа.dat. Создание и проверку системы, как и раньше, про-
ведем по этапам. 

1. В окне АNFIS-редактора выберем тип загружаемых данных 
Training и нажмем кнопку Load data. В последующем стандартном окне 
диалога укажем местоположение и имя файла. Его открытие приводит  
к появлению в графической части окна редактора набора точек, соответ-
ствующих введенным данным. 

2. В группе опций Generate FIS по умолчанию активизирован вари-
ант Grid partition. Не будем изменять и нажмем кнопку Generate FIS,  
после чего появится диалоговое окно для задания числа и типов функций 
принадлежности. Сохраним вес установки по умолчанию, согласившись  
с ними нажатием кнопки ОК. Произойдет возврат к основному окну  
АNFIS-редактора. Теперь структура гибридной сети создана, и ее графиче-
ский вид можно просмотреть с помощью кнопки Structure. 

3. Перейдем к опциям Train FIS. Не будем менять задаваемые по 
умолчанию метод настройки параметров (hybrid – гибридный) и уровень 
ошибки (0), но количество циклов обучения изменим на 40, после чего 
нажмем кнопку запуска процесса обучения (Train Now). Получится ре-
зультат в виде графика ошибки сети в зависимости от числа проведенных 
циклов обучения (из которого следует, что фактически обучение закончи-
лось после пятого цикла). 

4. Теперь нажатием кнопки Test Now можно начать процесс тести-
рования обученной сети, но поскольку использовалась только одна (обу-
чающая) выборка, ничего особенно интересного ожидать не приходится. 
Действительно, выход обученной системы практически совпадает с точ-
ками обучающей выборки. 

5. Сохраним разработанную систему на диске в файле с именем 
Ргоbа1 (с расширением .fis). Для исследования разработанной системы 
средствами FIS-редактора из командной строки МАТLAВ выполним  
команду Fuzzy, а затем через пункты меню File | Ореn FIS from disk  
откроем созданный файл. С созданной системой можно теперь выпол- 
нять все приемы редактирования (изменение имен переменных и т. п.)  
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и исследования, которые были рассмотрены выше. В результате убежда-
емся, что качество аппроксимации существенно не улучшилось – слиш-
ком мало данных. 

Что можно сказать про эффективность использования гибридных си-
стем (и ANFIS-редактора)? 

В данном случае используется только один алгоритм нечеткого вы-
вода – Sugeno (нулевого или первого порядков), может быть только одна 
выходная переменная, всем правилам приписывается один и тот же еди-
ничный вес. Вообще говоря, возникают значительные проблемы при 
большом (более 5–6) количестве входных переменных. Это – ограничения 
и недостатки подхода. 

Его несомненные достоинства: практически полная автоматиза-
ция процесса создания нечеткой (гибридной) системы, возможность 
просмотра сформированных правил и придания им содержательной 
(лингвистической) интерпретации, что позволяет, кстати говоря, рас-
сматривать аппарат гибридных сетей как средство извлечения знаний 
из баз данных и существенно отличает данные сети от классических 
нейронных. 

Рекомендуемая область применения: построение аппроксиматоров 
зависимостей по экспериментальным данным, построение систем класси-
фикации (в случае бинарной или дискретной выходной переменной),  
изучение механизма явлений. 

Затем работу с редактором рассмотрим на примере своей зависи-
мости y от x, заданной по вариантам. 
 

Лабораторная работа № 3 
 

Графический интерфейс программы кластеризации 
 
Цель работы. Использовать программу Clustering (Кластериза-

ция) для выявления центров кластеров, т. е. точек в многомерном про-
странстве данных, около которых группируются (скапливаются) экспе-
риментальные данные. Выявление подобных центров  является значимым 
этапом при предварительной обработке данных, поскольку позволяет со-
поставить с этими центрами функции принадлежности переменных при 
последующем проектировании системы нечеткого вывода. 

Запуск программы Clustering осуществляется командой (функцией) 
findcluster. В появляющемся окне программы имеется (вверху) главное 
меню, содержащее достаточно стандартный набор пунктов (File, Edit, 
Window, Help) и набор управляющих кнопок и опций (справа). К этим 
кнопкам относятся: 

o  кнопка загрузки файла данных – Load Data; 
o кнопка выбора алгоритма кластеризации – Method; 
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o четыре расположенные ниже кнопки опций алгоритма (их назва-
ния меняются в зависимости от выбранного алгоритма); 

o кнопка начала итеративного процесса нахождения центров кла-
стеров (кластеризации) – Start; 

o кнопка сохранения результатов кластеризации – Save Center; 
o кнопка очистки (стирания) графиков – С1еаг Р1оt; 
o кнопка справочной информации – Info; 
o кнопка завершения работы с программой – С1оsе. 
В программе используются два алгоритма выявления центров кла-

стеров: Fuzzy c-means, который можно перевести как «Алгоритм нечет-
ких центров», и Subtractive clustering «Вычитающая кластеризация». 
Ограничившись выявлением различий на уровне пользователя, можно 
отметить, что алгоритм Fuzzy c-means является, пожалуй, более точным 
(если понятие точности вообще здесь применимо). Для своей работы тре-
буется задание таких опций, как число кластеров (кнопка Cluster num) и 
число итераций (кнопка Мах Iteration#). Ну если число итераций еще 
можно задать как-то наугад, то ошибка в задании числа кластеров может 
в будущем привести к неприятным последствиям. Алгоритм Subtractive 
clustering менее точен, но и менее требователен к априорной информа-
ции; при работе с ним можно сохранить опции, заданные в программе по 
умолчанию.  

Далее приведен пример использования программы для файла дан-
ных clusterdemo.dat из директории Маtlab/toolbox/fuzzy/fuzdemos/  при 
использовании алгоритма Subtractive clustering. Заметим, что выводится 
только двумерное поле рассеяния, но, изменяя переменные в соответ-
ствующих полях (Х-axis и Y-ахis), можно «просмотреть» все многомер-
ное пространство переменных. 

Задание к лабораторной работе 

1. Подготовить данные и сохранить их  в файле Proba.dat в виде 

–1          1 
–0.6      0.36 
  0.0       0.00 
  0.4       0.16 
  1            1 

2. При запуске программы Clustering, используя приведенный выше 
материал, выявить центры кластеров, то есть точки, около которых груп-
пируются (скапливаются) экспериментальные данные. 

3. Подготовить данные для своей зависимости y от x, заданной по 
варианту, выявить центры кластеров. 

4. Сохранить результаты кластеризации на своем диске. 
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Лабораторная работа № 4 
 

Использование графического интерфейса для построения  
нечеткой аппроксимирующей системы 

 

Цель работы. Построение нечеткой экспертной системы. 
Рассмотрим методику построения нечеткой экспертной системы, 

которая должна помочь пользователю с ответом на вопрос «Сколько дать 
на чай официанту за обслуживание в ресторане?» 

На основании каких-то устоявшихся обычаев и интуитивных пред-
ставлений предположим, что задача о чаевых может быть описана следу-
ющими предложениями. 

1) если обслуживание плохое или еда подгоревшая, то чаевые – ма-
ленькие; 

2) если обслуживание хорошее, то чаевые – средние; 
3) если обслуживание отличное или еда превосходная, то чаевые – 

щедрые. 
Качество обслуживания и еды будем оценивать по 10-балльной си-

стеме (0 – наихудшая оценка, 10 – наилучшая). 
Будем предполагать далее, что малые чаевые составляют около 5% 

от стоимости обеда, средние – около 15 % и щедрые – примерно 25 %. 
Заметим, что представленной информации, в принципе, достаточно 

для проектирования нечеткой экспертной системы. Такая система будет 
иметь два входа (которые можно условно назвать «сервис» и «еда»), один 
выход («чаевые»), три правила типа «если….то» в соответствии с тремя 
приведенными предложениями и по три значения (соответственно 0 бал-
лов, 5 баллов, 10 баллов и 5%, 15%, 25%) для центров функций принад-
лежности входов и выходов. Построим данную систему, используя алго-
ритм Мамдани, описывая требуемые действия по пунктам. 

Задание к лабораторной работе 
1. Командой Fuzzy запускаем FIS-редактор. По умолчанию предла-

гается алгоритм Мамдани (о чем говорит надпись в центральном белом 
блоке), и здесь никаких изменений не требуется, но в системе должно быть 
два входа, поэтому через пункт меню Edit> Add Variable Input   добавля-
ем в системе этот второй вход (в окне редактора появляется второй желтый 
блок с именем Input2). Делая далее однократный щелчок на блоке 
Input1,меняем его имя на «сервис», завершая ввод нового имени нажатием 
клавиши . Аналогичным образом устанавливаем имя «еда» блоку Input2 и 
«чаевые» – выходному блоку Output1(справа вверху). Присвоим сразу же 
и имя всей системе, например TIP_ FIO. Зададим теперь функции принад-
лежности переменных. Программу – редактор функции принадлежности 
можно открыть тремя способами: выберем первый через пункт меню 
View> Edit membership function. Задание и редактирование функций  
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принадлежности начнем с переменной «сервис». Сначала в полях Range и 
Display Range установим диапазон изменения и отображения этой пере-
менной – от 0 до 10 (баллов), подтверждая ввод нажатием клавиши Enter. 
Затем через пункт меню  Edit/Add MFs перейдем к диалоговому окну вида, 
показанного на рис. 2. 

 

 
 

Рис. 2. Вид окна FIS Editor 
 

 
 

Рис. 3. Окно задания функции принадлежности пользователя 
 
Как показано на рис. 3, зададим  три функции принадлежности 

гауссова типа (gaussmf). Нажмем кнопку ОК и возвратимся в окно редак-
тора функций принадлежности. Не изменяя размах и положение заданных 
функций, заменим только их имена на «плохой», «хороший» и «отлич-
ный». Щелчком на значке «еда» войдем в окно редактирования функций 
принадлежности для этой переменной. Зададим сначала диапазон ее изме-
нения от 0 до 10, а затем, поступая как ранее, зададим две функции  
принадлежности трапецеидальной формы с параметрами соответственно  
[0 0 1 3] и [7 9 10 10] и именами «подгоревшая» и «превосходная». 

Для выходной переменной «чаевые» укажем сначала диапазон из-
менения (от 0 до 30), потом зададим три функции принадлежности тре-
угольной формы с именами «малые», «средние» и « щедрые» так, как 
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представлено на рис.4. Заметим, что можно, разумеется, задать и какие-
либо другие функции или выбрать другие параметры. 

2. Перейдем к конструированию правил. Для этого выберем пункт 
меню View>Edit rules. Далее ввод правил производится в соответствии  
с предложениями, описывающими задачу. Заметим, что в первом и третьем 
правилах в качестве «связки» в предпосылках правила необходимо исполь-
зовать не «И» (and), а «ИЛИ» (or); при вводе второго правила, где отсут-
ствует переменная «еда», для нее выбирается опция none. В результате 
формируется итоговый набор правил. 

 

 
 

Рис. 4. Функции принадлежности переменной «чаевые» 
 

Такая подробная (verbose) запись представляется достаточно понят-
ной; единица в скобках после каждого правила указывает его «вес» 
(Weight), т. е. значимость правила. Данный вес можно менять, используя 
соответствующее поле в левой нижней части окна редактора правил. Пра-
вила представлены и в других формах – символической (symbolic)  и ин-
дексной (indexed); при этом переход от одной формы к другой происходит 
с помощью меню Options> Format редактора правил. Вот как выглядят рас-
смотренные правила в символической форме: 

(сервис==плохой)I(еда==подгоревшая)=>(чаевые==малые)(1); 
(сервис==хороший)=>(чаевые==средние)(1); 
(сервис==отличный)I(еда==превосходная)=>(чаевые==щедрые)(1). 
Правила понятны. 
Наконец, самый сжатый формат представления правил – индекс- 

ный – является тем форматом, который в действительности используется 
программой. В этом формате приведенные правила выглядят так: 

o 1  1,  1  (1):2 
o 2  0,  2  (1):2 
o 3  2,  3  (1):2 
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Здесь первая колонка относится к первой входной переменной (соот-
ветственно первое, второе или третье возможное значение), вторая – ко 
второй, третья (после запятой) – к выходной переменной, цифра (после 
двоеточия) указывает тип «связки» (1 для «И», 2 для «ИЛИ»). 

На этом соответственно конструирование экспертной системы за-
кончено. Сохраним ее на диске под выбранным именем TIP. 

Теперь самое время проверить систему в действии. Откроем (через 
пункт меню View > View rules) окно просмотра правил и установим значе-
ния переменных: сервис = 0 (то есть никуда негодный), еда = 10 (то есть 
превосходная). Увидим ответ: чаевые = 15 (то есть средние). Ну что ж,  
с системой не поспоришь, надо платить. 

Можно проверить и другие варианты. В частности (может быть, не 
без удивления), выяснится, что нашей системой обслуживание ценится 
больше, чем качество еды: при наборе «сервис = 10, еда = 3» система  
советует определить размер чаевых в 23,9 %, в то время как набору «сер-
вис = 3, еда = 10» размер чаевых по рекомендации системы – 16,6 %  
(от стоимости обеда). Впрочем, ничего удивительного здесь нет: это мы 
сами (не особенно подозревая об этом) заложили в систему соответствую-
щие знания в виде совокупности приведенных правил. 

Подтверждением отмеченной зависимости выходной переменной  
от входных может служить вид поверхности отклика, который представля-
ется при выборе пункта меню View/View surface; обратите внимание, что  
с помощью мышки график можно поворачивать во все стороны. 

В открывшемся окне, меняя имена переменных в полях ввода  
X (input) и Y (input)), можно задать и просмотр одномерных зависимостей, 
например «чаевых» от «еды». 

По приведенному выше примеру подготовим свою экспертную  
систему, протестируем ее и сохраним под именем EсFio, оформив отчет  
в виде, представленном в начале лабораторной работы № 4. 

 
Лабораторная работа № 5 

 

Создание пользовательских функций принадлежности 
 

Цель работы. Работа с Fuzzy Logic Тооlboх  в режиме командной 
строки. Возможности работы в режиме командной строки. Функции си-
стем нечеткого вывода. Функции сохранения, открытия и использования 
созданной системы. 

Пакет Fuzzy Logic Тооlboх  располагает большим набором функ-
ций, исполняемых из командной строки МАТLАВ и позволяющих не ис-
пользовать при работе с системами нечеткого вывода рассмотренные про-
граммы графического интерфейса. Все функции делятся на группы: 

1) вызов программ графического интерфейса; 
2) задание функций принадлежности; 
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3) создание, редактирование, просмотр, открытие и сохранение си-
стем нечеткого вывода; 

4) дополнительные; 
5) сервисные; 
6) вызов диалоговых окон интерфейса; 
7) вызов блоков Simulink; 
8) демонстрация возможностей пакета. 

 

Функции вызова программ графического интерфейса 
 

К этой группе относятся следующие функции: 
• fuzzy – вызов FIS-редактора; 
• mfedit – вызов редактора функций принадлежности; 
• ruleedit – вызов редактора правил; 
• ruleview – вызов программы просмотра правил; 
• surfview – вызов программы просмотра поверхности отклика; 
• anfisedit – вызов FIS-редактора (только для систем, использующих алго-
ритм Sugeno и имеющих одну выходную переменную); 
• findcluster – вызов программы кластеризации. 

Использование первых шести функций с аргументом (например, 
fuzzy(а), где а – имя переменной рабочего пространства, присвоенное си-
стеме нечеткого вывода) открывает соответствующую программу с одно-
временной загрузкой в нее рассматриваемой системы. Функция findcluster 
(имя_файла) открывает программу кластеризации с одновременной загруз-
кой указанного файла данных. 

Чтение, использование и сохранение на диске созданной системы 
нечеткого вывода в режиме командной строки осуществляются следую-
щими функциями: 

readfis (‘имя_файла’); 
evalfis (вектор_параметров, имя); 
writefis (имя) или writefis (имя.'имя_файла'). 
Здесь имя_файла – наименование файла с написанной системой (без 

указания расширения), имя – идентификатор, который дан системе в рабо-
чей среде МАТLАВ. Вектор_параметров – набор значений входов, для ко-
торых требуется рассчитать выход (возможна и матрица параметров, тогда 
результат расчетов – вектор в случае одной выходной переменной или 
матрица при нескольких таких переменных). 

Задания к лабораторной работе 
1. На примере системы, ранее созданной и сохраненной на диске  

в виде файла с именем Tip (экспертной системы для задачи о чаевых),  
использовать системы нечеткого вывода с помощью графического интер-
фейса, приведенного выше: 
>>a = readfis ('Tip'); 
>>out = evalfis ([1 2],a) 
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   out = 
            <результат> 
>>writefis (a, ‘Tip’) 

Выбрать следующие функции использования графического окна, 
которые позволяют использовать элементы графических изображений вне 
программ с графическим интерфейсом. 

Команда (функция) plotfis (а) вызовет появление графического  
окна МАТLАВ с мнемоническим представлением разработанной системы 
(рис. 5.1). 

 
 

Рис 5.1. Мнемоническое представление системы  
нечеткого вывода 

 

Команда (функция) gensurf (a) также делает то же самое, но приме-
нительно к поверхности отклика (рис. 5.2). 

 

 
 

Рис.5.2. Результат выполнения функции gensurf (имя) 
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2. Далее выполнить пример построения экспертной системы для за-
дачи о чаевых, используя функции создания, просмотра структуры и ре-
дактирования систем нечеткого вывода:  функции newfis (новая система), 
addvar (добавить переменную), addmf (добавить функцию принадлежно-
сти) и addrule (добавить правило). 

3. Сконструировать систему нечеткого вывода целиком в режиме 
командной строки МАТLАВ. 

 
Затем точно так же указать все для «еды» и для «чаевых», только за-

менить ‘input’ на ‘output’. 
  ruleList=[ 
    1 1 1 1 1 
    1 2 2 1 1]; 
a = addrule(a,ruleList) 
Далее при необходимости просмотра элементов структуры (систе- 

мы с идентификатором а) в режиме командной строки следует ввести ко-
манду вида а. параметр, например 

>> a.type 
Получим ответ: 
ans = 
mamdani 
Получение информации по всем элементам структуры обеспечива- 

ется функцией getfis (а). 
Функция setfis (a) в определенном смысле противоположна функции 

getfis (а) и позволяет изменять параметры. 
Полный просмотр структуры системы нечеткого вывода осуществля-

ется функцией showfis (а). 
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Просмотр правил, включенных в систему нечеткого вывода, осу-
ществляется с помощью функции showrule (a) 

a = readfis('tipper'); 
showrule(a,1) 
ans = 
1. If (service is poor) or (food is rancid) then (tip is cheap) (1) 
 
showrule(a,2) 
ans = 
2. If (service is good) then (tip is average) (1) 
 
showrule(a,[3 1],'symbolic') 
ans = 
3. (service==excellent) | (food==delicious) => (tip=generous) (1) 
1. (service==poor) | (food==rancid) => (tip=cheap) (1) 
showrule(a,1:3,'indexed') 
ans = 
1 1, 1 (1) : 2 
2 0, 2 (1) : 1 
3 2, 3 (1) : 2 
 
4. Повторить весь процесс с применением указанных программ для 

своей экспертной системы, созданной в лабораторной работе № 4, на при-
мере построения системы в задаче о чаевых. 

 
Лабораторная работа № 6 

 
Средства для проектирования, моделирования, обучения  

и макроязык программирования искусственных нейронных сетей 
 

Цель работы. Использование пакета Neural Networks Тооlbох, кото-
рый позволяет создавать, обучать нейронные сети. 

В состав пакета Neural Networks Тооlbох (Нейронные сети) входят 
более 150 различных функций, что позволяет пользователю создавать, 
обучать и использовать самые различные искусственные нейронные сети 
(ИНС). Пакет может быть использован для решения множества разнооб-
разных задач, таких, как обработка сигналов, нелинейное управление, фи-
нансовое моделирование и т. п. 

Для каждого типа архитектуры и обучающего алгоритма ИНС име-
ются функции инициализации, обучения, адаптации, создания, моделиро-
вания, демонстрации, а также примеры применения. Искусственные мно-
гослойные нейронные сети конструируются по принципам построения их 
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биологических аналогов. Они уже сейчас способны решать широкий круг 
задач распознавания образов, идентификации, управления сложными не-
линейными объектами, роботами и т. п. 

Представим некоторые проблемы, решаемые в контексте ИНС и 
представляющие интерес для пользователей. 
  Классификация образов. Задача состоит в указании принадлежности 

входного образа (например, речевого сигнала или рукописного симво-
ла), представленного вектором признаков, к одному или нескольким 
предварительно определенным классам. К известным приложениям от-
носятся распознавание букв, распознавание речи, классификация сигна-
ла электрокардиограммы, классификация клеток крови. 

 Кластеризация/категоризация. При решении задачи кластеризации, 
которая известна и как классификация образов «без учителя», отсут-
ствует обучающая выборка с метками классов. Алгоритм кластеризации 
основан на подобии образов и помещает близкие образы в один кластер. 
Известны случаи применения кластеризации для извлечения знаний, 
сжатия данных и исследования свойств данных. 

 Аппроксимация функций. Предположим, что имеется обучающая  
выборка ((х1,у1), (х2,у2)..., (XN, уn)) (пары данных «вход–выход»), которая 
генерируется неизвестной функцией F(x), искаженной шумом. Задача 
аппроксимации состоит в нахождении оценки неизвестной функции 
F(x). Аппроксимация функций необходима при решении многочислен-
ных инженерных и научных задач моделирования. 

 Предсказание/прогноз. Пусть заданы п дискретных отсчетов {y(t1), 
y(t2), y(tk)} в последовательные моменты времени t1, t2, ...,tk .-Задача со-
стоит в предсказании значения y(tk-1) в некоторый будущий момент 
времени tk-1. Предсказание/прогноз имеет значительное влияние на при-
нятие решений в бизнесе, науке и технике. Предсказание цен на фондо-
вой бирже и прогноз погоды являются типичными приложениями тех-
ники предсказания/прогноза. 

 Оптимизация. Многочисленные проблемы в математике, статистике, 
технике, науке, медицине и экономике могут рассматриваться как про-
блемы оптимизации. Задачей алгоритма оптимизации является нахож-
дение такого решения, которое удовлетворяет системе ограничений и 
максимизирует или минимизирует целевую функцию. Известная зада-
ча коммивояжера является классическим примером задачи оптими- 
зации. 

 Память, адресуемая по содержимому. В модели вычислений фон 
Неймана обращение к памяти доступно только посредством адреса, ко-
торый не зависит от содержимого памяти. Более того, если допущена 
ошибка в вычислении адреса, то может быть найдена совершенно иная 
информация. Ассоциативная память, или память, адресуемая по содер-
жимому, доступна по указанию заданного содержимого. Содержимое 
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памяти может быть вызвано даже по частичному входу или искаженно-
му содержимому. Ассоциативная память чрезвычайно желательна при 
создании мультимедийных информационных баз данных. 

 Управление. Рассмотрим динамическую систему, заданную сово- куп-
ностью u(t), y(t), где u(t) является входным управляющим воздействием, 
a  y(t) – выходом системы в момент времени в системах управления  
с эталонной моделью. Целью управления является расчет такого вход-
ного воздействия u(t), при котором система следует по желаемой траек-
тории, диктуемой эталонной моделью. Примером является оптимальное 
управление двигателем. 

Эти и подобные задачи успешно решаются средствами пакета Neural 
Networks Тооlbох. 

Net=newgrnn – (P,T,speread) – функция создания обобщенно-регрес- 
сионной сети. 

Задания к лабораторной работе 
1. Выполнить пример создания и использования нейронных сетей 

для аппроксимации функции на примере своей заданной функции по сво- 
ему варианту, используя нижеуказанный пример. Создадим обобщенно-
регрессионную НС с именем A для аппроксимации функции вида у = х2 на 
отрезке [–1, 1], используя следующие экспериментальные данные (10 то-
чек), со знака % вводятся комментарии. 

Х = [–1  –0.8  -0.5  0.2  0  0.1  0.3  0.6  0.9  1] 
Y = [1  0.64  0.25  0.04  0  0.01  0.09  0.36  0.81  1] 
>> % Задание входных значений 
>> P = [–1 –0.8 –0.5 0.2 0 0.1 0.3 0.6 0.9 1]; 
>> % Задание выходных параметров 
>> T = [1 0.64 0.25 0.04 0 0.01 0.09 0.36 0.81 1]; 
>> a = newgrnn(P,T,0.01);    % Создание НС  
>> P1 = [–0.9 –0.7 -0.3 0.4 0.8] 
P1 = 
       –0.9000   –0.7000   –0.3000    0.4000    0.8000 
>> Y = sim(a,P1) % Опрос НС 
Y = 
      0.8200    0.6400    0.2500    0.0900    0.8100 
Как видно, точность аппроксимации в данном случае получилась не 

очень высокой. 
Можно попытаться  улучшить качество аппроксимации за счет под-

бора величины отклонения, но в условиях примера приемлемый результат 
легко достигается при использовании сети с радиальными базисными эле-
ментами: 

a=newrbe(P,T);  
>> P1 = [–0.9 –0.7 –0.3 0.4 0.8]; 
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>> Y = sim(a,P1) % Опрос НС 
Y =    0.8099    0.4901    0.0900    0.1600    0.6400 
Созданную сеть можно сохранить для последующего использования 

набором в командной строке команды save ('a’); при этом будет создан 
файл a.mat, то есть файл с именем НС и расширением .mat. В последую-
щих сеансах работы можно загрузить сохраненную сеть используя функ-
цию load(‘a’). 

2. Теперь создадим сеть для своей функции. Сохранить на своем диске. 
3. Рассмотрим аналогичную задачу, но с использованием линейной НС. 
Пусть экспериментальная информация задана значениями 
Х = 1      1.5     3    –1.2 
Y = 0.5   1.1     3    –1 
Процесс создания, обучения и использования линейной НС с име- 

нем b приведен ниже  и иллюстрируется приведенным ниже листингом  
и рис. 6. 

 
Рис 6. Изменение ошибки сети в процессе ее обучения 

 
>>P =  [1 1.5 3 –1.2];  
>> T = [0.5 1.1 3 –1];  
>> % Определение величины коэффициента обучения 
>> maxlr=maxlinlr(P,'bias'); 
>> b=newlin([-2 2],1,[0],maxlr); 
>> b.trainParam.epochs=15; % Задание кол-ва циклов обучения 
>> b = train(b,P,T); % Обучение НС 
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TRAINB, Epoch 0/15, MSE 2.865/0. 
TRAINB, Epoch 15/15, MSE 0.0730734/0. 
TRAINB, Maximum epoch reached. 
>> p = –1.2; 
% Опрос сети 
>> y = sim(b,p)  
y =   
       –1.1803 
4. Использование слоя Кохонена. Рассмотрим задачу автоматическо-

го выявления (в режиме обучения без учителя) центров кластеров входов 
для двумерного случая с использованием слоя Кохонена (слоя «соревную-
щихся» нейронов). Решение данной задачи приведено ниже. 
» % Задание диапазонов возможного положения центров кластеров 
» X = [0  1;    0  1]; 
» % Задание параметров для моделирования исходных данных. 
» % принадлежащих 8 классам (кластерам)) 
» clusters = 8; 
» points = 10; 
» std_dev = 0.05; 
» % Моделирование входных данных 
» P = nngenc(X,clusters,points,std_dev); 
» % Создание слоя Кохонена 
» net = newc([0 1; 0 1],8,1); 
» % Задание количества циклов обучения 
» net.trainParam.epochos=500; 
» % Инициализация сети 
» net=init(net); 
» % Обучение сети 
» net=train(net,P); 
» w=net.IW{1}; 
» % Вывод  графика исходных данных и выявленных центров кластеров 
» plot(P(1,:),P(2,:),'+r'); 
» hold on; 
» plot(w(:,1),w(:,2),'ob'); 
» xlabel('p(1)'); 
» ylabel('p(2)'); 
» % Задание нового входного вектора 
» p = [0; 0.2]; 
»y = sim(net,p)   % Опрос сети 
y =   (8,1)        1 

Работа обученной сети иллюстрируются  рис. 7, 8, и результат ее 
опроса – матрица у в конце приведенного листинга, которая выдается  
в форме разреженной матрицы. В условиях примера предъявленный вектор 
отнесен к третьему классу (кластеру). Сохранить сеть на диске. 
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Рис. 7. Исходные данные 
 

 
 

Рис. 8. Исходные данные и выявленные центры кластеров 
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